Application Note
Renesas Synergy™ Platform

Installing IAR Compiler into e2 studio and Migrating Projects
between Compilers
1. Install IAR Embedded Workbench® for Renesas Synergy™ (IAR EW for Synergy)
1. Go to the Development Tools page in the website:
https://www.renesas.com/en-us/products/synergy/software/tools.html
2. Click the Explore IAR EW for Synergy link to open the IAR Embedded Workbench for Renesas
Synergy page.
3. Scroll down to click the Download button to download the current public release of IAR Installer. You
may need to sign into the Synergy gallery at this stage.
4. Accept the SSP Tool License agreement.
5. Click the Acquire License button and enter your email address if requested.
6. Double-click the downloaded file to install the IAR tool chain.
7. Continue the install using the default option provided until the installation is complete.

2. Install e2 studio
1. Go to the Development Tools page in the website:
https://www.renesas.com/en-us/products/synergy/software/tools.html
2. Click the Explore e2 studio link to open the e2 studio page.
3. Scroll down to click the Download link to download e2 studio.
4. Double click the downloaded file (e2 studio) to launch the Platform installer.
Note: Select the default option whenever possible.

2.1

Install IAR plugins in e2 studio

1. Launch e2 studio once the installation is complete.
2. Go to the Help menu and select IAR Embedded Workbench plugin manager.
Note: This step requires e2 studio to access an external server to download the necessary IAR plugins. You
may need to configure HTTP and HTTPS proxy settings under Window > Preferences > General >
Network Connection.
3. e2 studio displays a list of available plugins that could be installed.
A. The left pane displays the major versions of IAR Arm® compiler.
B. The right pane displays the version of the selected IAR Embedded Workbench installation.
4. Select the appropriate version of the Synergy plugin and click Install.
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5. Select all the plugins displayed. Click Next to continue the install and accept the terms of the license
agreement.

This process will take approximately 5-10 minutes. The progress can be seen in the bottom right corner of
the status bar in e2 studio.
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6. Click OK when the Security Warning dialog shows.

7. Allow the installation of the plugins to complete, this may take some time.

Allow e2 studio to restart. Creating a new Synergy project will now show the options of the new toolchain.
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8. In e2 studio, go to the menu Window > Preferences > IAR Embedded Workbench Setup and browse to
the IAR EW for Synergy installation folder, if needed.

The IAR toolchain will now be available in the new Synergy Project dialog.

3.

Migration of GCC project to IAR

Automatic migration of an existing GCC project to IAR is not supported. However, it is possible for you to
manually port a project using the following steps.
Note: You can follow this approach at your own risk. Compiler settings, user setting, linker script changes,
and so on that were made in the GCC project will not be carried across to the new project. It is your
responsibility to make the necessary changes and perform suitable testing to ensure the project
functionality.
1. Open the existing GCC project in e2 studio and then open the configurator by double clicking on the
configuration.xml file.
2. If the SSP pack of the selected project is missing (see the following example), install the Synergy
Software Package version needed.

Note: You will need to sign in to MyRenesas to see All Versions of the SSP near the bottom of the
page.

R11AN0272EU0104 Rev.1.04
Apr.02.19

Page 4 of 9

Renesas Synergy™ Platform

Installing IAR Compiler into e2 studio and Migrating Projects
between Compilers

3. Create a new project selecting the IAR compiler and the same device as the GCC project.

4. Where possible, be sure to select the same SSP version as the original GCC project.
Note: If this is not possible, you will be asked to update the project (as described above) when the
configuration file is opened in following steps.
5. Delete the src folder from the new IAR project.
6. Select the src folder in the GCC project and copy it (right click and select copy from the options or use
CTRL+C).
7. Select the new IAR project and paste the src folder to the new project (right click and select paste from
the options or use CTRL+V).
8. Copy the configuration.xml file from the GCC project and paste it into the new IAR project.
9. Click Yes To All if a message dialog pops up.

R11AN0272EU0104 Rev.1.04
Apr.02.19

Page 5 of 9

Renesas Synergy™ Platform

Installing IAR Compiler into e2 studio and Migrating Projects
between Compilers

10. Copy *.pincfg from the GCC project to the IAR project.
11. Open the configuration.xml file.
If the SSP pack of the selected project is missing (see the following example), install the needed
Synergy Software Package version or update the project as needed.

Note: You will need to sign in to MyRenesas to see All Versions of the SSP near the bottom of the
page.
12. Click the Generate Project Content to add the IAR compatible SSP files to the project.

13. Manually update any compiler and linker settings as needed.
14. Build the project that will now use the IAR compiler.
Note: Default compiler and linker settings will be used and may need to be modified to suit the target
application.
15. Test the built project.
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Migration of IAR project to GCC

Automatic migration of an existing GCC project to IAR is not supported. However, it is possible for you to
manually port a project using the same steps mentioned in Migration of GCC project
The project to be migrated is an IAR project and the new project created will be created with GCC toolchain
Note: You can follow this approach at your own risk. Compiler settings, user setting, linker script changes,
and so on that were made in the IAR project will not be carried across to the new project. It is your
responsibility to make the necessary changes and perform suitable testing to ensure the project
functionality.

5.

Migration of existing project with old version of IAR toolchain to a new major
version of IAR toolchain

Projects created with an old version of the IAR toolchain might not always migrate correctly to a major, new
version of IAR toolchain when opened in e2 studio, resulting in build failures. Follow the steps from section 3,
Migration of GCC project to IAR, to open an existing project with old version of IAR toolchain.
Note: Do NOT use the Tool Chain Editor under the C/C++ Build preferences as many compiler settings may
not migrate correctly and can cause project to fail build or lock devices accidentally.
To summarize:
1. Create a new project using the new major version of IAR (for example, IAR V8.x) with same SSP version
used by the existing project with old version of IAR toolchain (for example, IAR 7.x).
2. Copy the src folder, configuration.xml, and *.pincfg from the existing project to the new project.
3. Open configuration.xml file from the new project and generate project content.
4. Build and test the new project.

6. Migration of existing project with old version of GCC to new major version of
GCC toolchain
Projects created with GCC 4.9 can be migrated using the following steps.
To import the project created with GCC 4.9 to e2 studio 7.3.0:
1. Select the project in project explorer, right click and select Properties.
2. In Toolchain tab of settings, verify “Use integrated Toolchain version” selected and the latest GCC version
which is 7.2.1.
3. Click Apply and close.

4. Open the Synergy configurator and verify that the GCC version is the one selected in Properties view.
5. Generate the project, clean the project, and rebuild the whole project.
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Website and Support
Visit the following vanity URLs to learn about key elements of the Synergy Platform, download components
and related documentation, and get support.
Synergy Software
Synergy Software Package
Software add-ons
Software glossary
Development tools

www.renesas.com/synergy/software
www.renesas.com/synergy/ssp
www.renesas.com/synergy/addons
www.renesas.com/synergy/softwareglossary
www.renesas.com/synergy/tools

Synergy Hardware
Microcontrollers
MCU glossary
Parametric search
Kits

www.renesas.com/synergy/hardware
www.renesas.com/synergy/mcus
www.renesas.com/synergy/mcuglossary
www.renesas.com/synergy/parametric
www.renesas.com/synergy/kits

Synergy Solutions Gallery
Partner projects
Application projects

www.renesas.com/synergy/solutionsgallery
www.renesas.com/synergy/partnerprojects
www.renesas.com/synergy/applicationprojects

Self-service support resources:
Documentation
Knowledgebase
Forums
Training
Videos
Chat and web ticket

www.renesas.com/synergy/docs
www.renesas.com/synergy/knowledgebase
www.renesas.com/synergy/forum
www.renesas.com/synergy/training
www.renesas.com/synergy/videos
www.renesas.com/synergy/resourcelibrary
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Notice
1.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.
"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home
electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.
6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.
(Note1)
(Note2)

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
(Rev.4.0-1 November 2017)
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